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1.	Wstęp
Szanowny Kliencie,
Dziękujemy za zakup naszego produktu.
Wyrób ten jest zgodny z ustawowymi wymogami krajowymi i europejskimi.
Aby utrzymać ten stan i zapewnić bezpieczeństwo użytkowania, jako użytkownicy muszą Państwo przestrzegać  
niniejszych instrukcji obsługi!

	 Niniejsze instrukcje obsługi są częścią tego produktu. Zawierają ważne uwagi dotyczące przekazania do 
użytkowania oraz obsługi. Należy mieć to na uwadze w przypadku przekazywania produktu osobom trzecim.  
Instrukcje obsługi należy zachować w celu wykorzystania ich w przyszłości!

Potrzebujesz pomocy technicznej? Skontaktuj się z nami:
E-mail:	 bok@conrad.pl
Strona www:	 www.conrad.pl
Dane kontaktowe znajdują się na stronie kontakt: https://www.conrad.pl/kontakt
Dystrybucja Conrad Electronic Sp. z o.o, ul. Kniaźnina 12, 31-637 Kraków, Polska

2.	Wyjaśnienie symboli
	 Symbol pioruna w trójkącie jest używany, jeśli istnieje ryzyko dla zdrowia, np. z powodu porażenia prądem 
elektrycznym.

	 Symbol z wykrzyknikiem w trójkącie służy do podkreślenia ważnych informacji w niniejszej instrukcji obsługi.  
Zawsze uważnie czytaj te informacje.

	 Symbol strzałki sygnalizuje specjalne informacje i wskazówki związane z obsługą. 

3.	Zastosowanie zgodne z przeznaczeniem
Produkt ten jest przeznaczony do stosowania jako mikroskop cyfrowy. Wyposażony jest we wbudowany filtr po-
laryzacyjny redukujący olśnienie, pierścień świetlny LED oświetlający przedmioty oraz akumulator zapewniający 
przenośność. Rejestrowane obrazy można zapisywać na karcie microSD. Dostarczone oprogramowanie zapewnia 
dodatkowe funkcje i pozwala na obsługę mikroskopu z poziomu komputera.
Należy bezwzględnie unikać kontaktu z wilgocią, na przykład w łazienkach.
Aby zachować bezpieczeństwo i przestrzegać użycia zgodnego z przeznaczeniem, produktu nie można przebudowy-
wać i/lub modyfikować. Użycie produktu do celów, które nie zostały przewidziane przez producenta, może spowodo-
wać jego uszkodzenie. Dodatkowo nieprawidłowe użycie może spowodować inne zagrożenia. Dokładnie przeczytać 
instrukcję obsługi i przechowywać ją w bezpiecznym miejscu. Produkt można przekazywać osobom trzecim wyłącznie 
z dołączoną instrukcją obsługi.
Wszystkie nazwy firm i produktów są znakami handlowymi ich właścicieli. Wszystkie prawa zastrzeżone.
HDMI jest zarejestrowanym znakiem handlowym HDMI Licensing L.L.C.



5

4.	Zawartość opakowania
•	 Mikroskop cyfrowy 
•	 Zasilacz
•	 Kabel USB

•	 Przewód HDMI
•	 Akumulator
•	 Karta microSD o pojemności 

4 GB

•	 Przejściówka microSD na SD
•	 Ministatyw
•	 Instrukcja obsługi

5.	Aktualne instrukcje obsługi 
Pobierz aktualne instrukcje obsługi poprzez link www.conrad.com/downloads lub zeskanuj przed-
stawiony kod QR. Postępować zgodnie z instrukcjami wyświetlanymi na stronie internetowej.

6.	Wskazówki dotyczące bezpieczeństwa
Należy dokładnie przeczytać instrukcje obsługi i bezwzględnie przestrzegać informacji dotyczą-
cych bezpieczeństwa. Producent nie ponosi odpowiedzialności za zranienie lub zniszczenie mie-
nia wynikające z ignorowania zaleceń dotyczących bezpieczeństwa i prawidłowego użytkowania,  
zamieszczonych w niniejszej instrukcji obsługi. W takich przypadkach wygasa rękojmia/gwarancja.

a)	Ogólne informacje
•	 Urządzenie nie jest zabawką. Należy przechowywać je w miejscu niedostępnym dla dzieci i zwierząt domowych.
•	 Nie wolno pozostawiać materiałów opakowaniowych bez nadzoru. Te materiały nie powinny być używane  
przez dzieci do zabawy, ponieważ mogą być niebezpieczne.

•	 Chroń urządzenie przed ekstremalnymi temperaturami, bezpośrednim światłem słonecznym, silnymi 
wstrząsami, wysoką wilgotnością, wilgocią, palnymi gazami, oparami i rozpuszczalnikami.

•	 Nie wolno poddawać produktu naprężeniom mechanicznym.
•	 Jeżeli nie można bezpiecznie użytkować produktu, należy zrezygnować z  jego użycia i  zabezpieczyć 
go przed przypadkowym użyciem. Nie można zagwarantować bezpiecznego użytkowania produktu, który:
	- nosi widoczne ślady uszkodzeń, 
	- nie działa prawidłowo, 
	- był przechowywany przez dłuższy czas w niekorzystnych warunkach lub 
	- został poddany poważnym obciążeniom związanym z transportem.

•	 Z produktem należy obchodzić się ostrożnie. Wstrząsy, uderzenia lub upadek, nawet z niewielkiej wysokości,  
mogą spowodować uszkodzenie produktu.

•	 W przypadku jakichkolwiek wątpliwości dotyczących obsługi, bezpieczeństwa lub podłączania urządzenia  
należy skonsultować się ze specjalistą.

•	 Konserwacja, modyfikacje i naprawy powinny być wykonywane wyłącznie przez technika lub autoryzowane  
centrum serwisowe.

•	 W przypadku jakichkolwiek pytań, na które nie można odpowiedzieć na podstawie tej instrukcji obsługi, 
należy skontaktować się z naszym działem wsparcia lub pracownikiem technicznym.



6

b)	Podłączone urządzenia
•	 Należy również wziąć pod uwagę instrukcje bezpieczeństwa i obsługi innych urządzeń podłączonych 
do produktu.

c)	Lampka LED
•	 Uwaga, światło LED:

	- Nie patrz bezpośrednio w światło lampki LED!
	- Nie patrz w wiązkę światła bezpośrednio ani za pomocą przyrządów optycznych!

d)	Baterie (akumulatory)
•	 Należy wyjąć baterie (akumulatory) z urządzenia, jeżeli nie będzie ono używane przez dłuższy czas, aby 
zapobiec uszkodzeniu na skutek wycieku cieczy z baterii. W wypadku wycieku cieczy lub uszkodzenia  
baterii (akumulatorów) ich kontakt ze skórą może spowodować poparzenia kwasem, dlatego należy 
używać odpowiednich rękawic ochronnych.

•	 Baterie (akumulatory) należy przechowywać w miejscu niedostępnym dla dzieci. Nie wolno zostawiać 
baterie (akumulatory) bez nadzoru, ponieważ istnieje ryzyko połknięcia ich przez dzieci lub zwierzęta 
domowe.

•	 Baterii (lub akumulatorków) nie wolno demontować. zwierać ich końcówek, ani wrzucać do ognia. 
Nie wolno ładować baterii, które nie są do tego przystosowane. Istnieje ryzyko wybuchu!

e)	Zasilacz
•	 Podłącz urządzenie do gniazdka ściennego, do którego można uzyskać łatwy dostęp.
•	 Jako źródło zasilania należy stosować wyłącznie dostarczony zasilacz sieciowy.
•	 Zasilacz sieciowy należy podłączać wyłącznie do zwykłych gniazdek zasilania komunalnych instalacji 
elektrycznych. Przed podłączeniem zasilacza sieciowego należy sprawdzić, czy napięcie podane na 
zasilaczu jest zgodne z napięciem sieci elektrycznej.

•	 Nigdy nie podłączać ani nie odłączać zasilacza sieciowego mokrymi rękami.
•	 Nie należy wyjmować zasilacza sieciowego z gniazda, ciągnąc za przewód. Odłączać tylko trzymając 
za uchwyty na wtyczce.

•	 Podczas montażu produktu należy upewnić się, że kabel nie jest ściśnięty, zagięty ani że nie ulegnie 
uszkodzeniu przez ostre krawędzie.

•	 Kable należy zawsze kłaść w taki sposób, aby nikt nie mógł się o nie potknąć ani się w nie zaplątać. 
Mogłoby to spowodować niebezpieczeństwo poniesienia obrażeń.

•	 Ze względów bezpieczeństwa podczas burzy należy odłączyć zasilacz sieciowy od gniazda sieciowego.

f)	 Mikroskop
•	 Pył i  zanieczyszczenia z powietrza mogą spowodować pogorszenie jakości obrazu. Nie używać  
urządzenia w otoczeniu z dużym zapyleniem.

•	 Urządzenie może się nagrzewać w trakcie użytkowania. Nie oznacza to usterki.
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7.	Elementy robocze
a)	Mikroskop cyfrowy

1	          Przycisk rejestrowania
2	  Zoom
3	 Pierścień filtra polaryzacyjnego
4	 Wskaźnik ładowania akumulatora
5	 Wyjście HDMI
6	 Wyjście telewizora
7	 Port 5 V/USB
8	 Obiektyw

9	 Punkt mocowania statywu (1/4”)
10	Gniazdo karty microSD
11	Pokrętło ostrości
12	Pokrętło jasności
13	Komora akumulatora
14	Wyświetlacz
15	Głośnik
16	  Menu ustawień

17	  Włączanie/wyłączanie zasilania
18	▲ W górę
19	  Tryb (zdjęcie/wideo/odtwarzanie)
20	OK Potwierdzanie
21	▼ W dół
22	MIC Mikrofon

b)	Wyświetlacz

028825M

2020/09/30 09:32:28

Ikona Opis

Zdjęcie

Wideo

Odtwarzanie
02882 Liczba pozostałych zdjęć
5 m Bieżąca rozdzielczość

Włożono kartę microSD

Pojemność akumulatora
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8.	Przygotowanie do pracy
a)	Wkładanie akumulatora
1.	 Zsuń pokrywę komory akumulatora i  włóż akumulator, jak 

pokazano na rysunku.
2.	 Zamknij komorę akumulatora.

b)	Ładowanie akumulatora
1.	 Podłącz jeden koniec przewodu do ładowania do portu 

5 V USB mikroskopu, a następnie drugi koniec do dołączonego  
zasilacza. 

2.	 Podłącz zasilacz do gniazda sieciowego.

	 Wskaźnik ładowania świeci na czerwono podczas ładowania i gaśnie po pełnym naładowaniu akumulatora.  
Stan akumulatora jest pokazywany na wyświetlaczu.

c)	Wkładanie karty microSD i formatowanie jej

1Wkładanie karty microSD
1.	 Włóż kartę (o  pojemności maks. 32  GB) do gniazda karty  

microSD w  kierunku pokazanym na rysunku. Zostanie  
zablokowana w odpowiednim położeniu.

2.	 Wyjmij kartę, naciskając ją końcem palca, a następnie zwol-
nij, aby ją wysunąć.

2Formatowanie karty microSD

 Ważne: Formatowanie powoduje usunięcie wszystkich danych. Przed przystąpieniem do formatowania 
utworzyć kopię zapasową ważnych danych.

1.	 Otwórz panel ekranu lub naciśnij przycisk  zasilania, aby włączyć lub wyłączyć mikroskop.
2.	 Naciśnij przycisk , aby wyświetlić menu konfiguracji.
3.	 Naciśnij przycisk ▲/ ▼, aby wybrać pozycję „Format”, a następnie naciśnij przycisk OK.
4.	 Naciśnij przycisk OK, aby wybrać pozycję „SD card” i ponownie naciśnij przycisk OK, aby rozpocząć formatowanie.

	 W przypadku formatowania karty na komputerze należy wybrać system plików FAT32. Więcej informacji 
można znaleźć w instrukcji obsługi systemu operacyjnego komputera.
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9.	Obsługa
a)	Wprowadzenie
1.	 Otwórz panel ekranu lub naciśnij przycisk  zasilania, aby włączyć lub wyłączyć mikroskop.
2.	 Ustaw obiektyw nad przedmiotem i dostosuj jasność oświetlenia LED za pomocą pokrętła jasności.
3.	 Obróć pokrętło ostrości, aby ustawić ostrość obrazu.
4.	 Obróć pierścień filtra polaryzacyjnego, aby zredukować olśnienie.

	 Automatyczne dopasowanie balansu bieli i ogniskowanie obrazu może zająć kilka chwil. Jeżeli przedmiot 
powoduje zbyt mocne olśnienie, należy rozważyć obniżenie jasności oświetlenia LED (lub jego całkowite 
wyłączenie).

b)	Wysokie i niskie powiększenie

1Wysokie powiększenie
•	 Obróć pokrętło ostrości do oporu w  lewo w pozycję „+”, a  następnie powoli obracaj pokrętło w  prawo, aż do  

uzyskania ostrości obrazu.
•	 Ogniskowa będzie krótka, dlatego można rozważyć ustawienie obiektywu bliżej przedmiotu.

2Niskie powiększenie
•	 Obróć pokrętło ostrości do oporu w  prawo w  pozycję „-”, a  następnie powoli obracaj pokrętło w  lewo, aż do  

uzyskania ostrości obrazu.

c)	Cyfrowy zoom
1.	 Użyj pierścienia ostrości, aby ustawić ostrość obrazu na wyświetlaczu LCD na przedmiocie.
2.	 Naciśnij przyciski , aby powiększyć + lub pomniejszyć -.

d)	Wybór trybu zdjęć lub wideo
1.	 Naciśnij przycisk , aby przełączać się między trybami zdjęć i wideo:

	- Tryb zdjęć:  pokazuje się na wyświetlaczu.
	- Tryb wideo:  pokazuje się na wyświetlaczu.

2.	 Naciśnij przycisk rejestrowania , aby zrobić zdjęcie lub rozpocząć/zatrzymać nagrywanie. 

	 Migająca czerwona ikona  wskazuje, że nagrywanie jest w toku.
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e)	Wyświetlanie zdjęć/odtwarzanie wideo
1.	 Naciskaj przycisk , aż zostanie wyświetlona ikona odtwarzania .
2.	 Naciśnij przycisk ▲/ ▼, aby wybrać zdjęcie lub wideo.

	- Zdjęcie jest oznaczone ikoną .
	- Wideo jest oznaczone ikoną . Naciśnij przycisk OK, aby odtworzyć wybrane wideo.

3.	 Naciśnij przycisk , aby wyświetlić więcej opcji, takich jak „Delete”, „Protect” (zapobieganie prz ypadkowemu 
usunięciu) i „Slide Show”. 
	- Naciśnij przycisk ▲/ ▼, aby wybrać pozycję menu.
	- Naciśnij OK, aby wybrać.

10.	Menu ustawień
a)	Uzyskiwanie dostępu do menu konfiguracji
1.	 Naciśnij przycisk , a następnie ▲/ ▼, aby wybrać zdjęcie lub wideo.

	- Zdjęcie jest oznaczone ikoną .
	- Wideo jest oznaczone ikoną . 

2.	 Naciśnij przycisk , aby uzyskać dostęp do menu konfiguracji zdjęcia lub wideo:
	- Naciśnij przycisk ▲/ ▼, aby przełączać/zmieniać wartość.
	- Naciśnij OK, aby wybrać.
	- Naciśnij przycisk , aby wrócić do poprzedniego menu.

b)	Pozycje menu
Pozycja menu Opis
PhotoResolution Wybór jakości obrazu.
VideoResolution Wybór jakości wideo.
WhiteBalance Tylko zdjęcia: wybór opcji „Auto” i „Daylight”.
LoopRecording Tylko wideo: wideo będzie nagrywane do nowego pliku po upływie określonego interwału. 
Time-lapseCapture Tylko zdjęcia: Ustawianie liczby zdjęć do zrobienia w wybranym okresie.
DateStamp Pokazanie godziny i daty na zdjęciu.
Date/Time Ustawianie bieżącej daty i godziny.
AutoPowerOff Ustawianie czasu automatycznego wyłączenia w przypadku braku aktywności.
Language Ustawianie języka interfejsu (angielski lub niemiecki).
TVOut Wybór systemu NTSC lub PAL.
Format Formatowanie karty microSD.
DefaultSetting Przywracanie ustawień fabrycznych.
Version Wyświetlanie informacji o wersji oprogramowania układowego.
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11.	Oprogramowanie PortableCapture Plus

 Ważne: 
•	 Po połączeniu z komputerem przyciski zostaną wyłączone. Do sterowania mikroskopem używa się wtedy 

oprogramowania „PortableCapture Plus”.
•	 Zdjęcia i wideo nagrane, gdy urządzenie jest połączone z komputerem, są zapisywane na dysku twardym 

komputera.

a)	Pobieranie i instalowanie oprogramowania
1.	 Odwiedź: www.conrad.com/downloads .
2.	 Wprowadź numer artykułu 2176727.
3.	 Wybierz folder odpowiadający systemowi operacyjnemu komputera (Windows® lub Mac), a następnie wybierz plik 

„PortableCapture_Plus”, aby zainstalować oprogramowanie.
4.	 Postępuj zgodnie z instrukcjami wyświetlanymi na ekranie, aby zakończyć proces instalacji.
5.	 Uruchom oprogramowanie, klikając ikonę utworzoną na pulpicie po zakończeniu instalacji.

	 Zmień język interfejsu, wybierając przykładowo pozycje Options > Language > German.

b)	Podłączanie mikroskopu
1.	 Podłącz jeden koniec przewodu USB do portu USB mikroskopu, a następnie drugi koniec do portu USB-A komputera.
2.	 Przy pierwszym połączeniu poczekaj trochę, aż komputer pobierze wymagane sterowniki i zainstaluje mikroskop 

jako nowe urządzenie. Postępuj zgodnie z instrukcjami wyświetlanymi na ekranie.
3.	 Uruchom oprogramowanie „PortableCapture Plus”. 
4.	 Naciśnij przycisk zasilania , aby włączyć mikroskop.
5.	 Naciśnij przycisk ▲/ ▼, aby wybrać pozycję „PCCamera”, a następnie naciśnij przycisk OK, aby potwierdzić wybór.

	 Uruchom ponownie oprogramowanie, jeżeli w  obszarze podglądu oprogramowania nie widać obrazu  
z mikroskopu. 
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c)	Podsumowanie
B1
B2

B3

B4

B5

B6

B7

B1	 Elementy menu:
	- File > Photos / Videos Folder: zarejestrowane obrazy są zapisywane na komputerze.
	- Options > Resolution: zmiana rozdzielczości rejestrowanych obrazów.
	- Options > Date /Time: pokazywanie/ukrywanie zarejestrowanej daty i godziny na zdjęciu lub wideo.
	- Options > Language: zmiana języka interfejsu użytkownika.
	- Options > XY Guide: pokazywanie/ukrywanie linii prowadzących.

B2	 Skróty: Camera/Video/Timer/Full Screen/Import 

B3	 Linie prowadzące osi X i Y
B4	 Obszar podglądu obrazu
B5	 Informacje na temat powiększenia
B6	 Karta zdjęć/wideo: wybierz kartę, aby przejrzeć zapisane zdjęcia lub wideo.
B7	 Okno zapisanych obrazów (widok miniatury).

	- Zarejestrowane zdjęcia/wideo są wyświetlane w formacie miniatur.
	- Po umieszczeniu wskaźnika myszy na miniaturze zdjęcie zostanie wyświetlone w obszarze podglądu (B4).
	- Kliknij obraz prawym przyciskiem myszy, aby wyświetlić więcej opcji, takich jak Open, Save as, Copy, Delete, 

Delete All.
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d)	Wykonywanie zdjęć 
1.	 Dostosuj mikroskop, tak aby obiektyw aparatu były blisko przedmiotu i ustawiony na niego.
2.	 Obserwując obraz w obszarze podglądu (B4), ustaw ostrość za pomocą pokrętła ostrości.

3.	 Aby zrobić zdjęcie, wybierz ikonę skrótu aparatu .
4.	 Zdjęcia będą przechowywane w folderze określonym za pomocą opcji File > Photos Folder.

	 Zarejestrowane zdjęcia są wyświetlane w oknie zapisanych obrazów jako miniatury (B7). Po najechaniu 
kursorem myszy na miniaturkę obraz zostanie wyświetlony w obszarze podglądu (B4). Zdjęcia są 
zapisywane w formacie JPG.

e)	Nagrywanie wideo
1.	 Dostosuj mikroskop, tak aby obiektyw aparatu były blisko przedmiotu i ustawiony na niego.
2.	 Obserwując obraz w obszarze podglądu (B4), ustaw ostrość za pomocą pokrętła ostrości.

3.	 Aby rozpocząć nagrywanie, kliknij ikonę skrótu wideo . Ikona zacznie migać, wskazując na to, że nagrywanie 
się rozpoczęło.

4.	 Kliknij migającą ikonę, aby zakończyć nagrywanie.
5.	 Wideo będą przechowywane w folderze określonym za pomocą opcji File > Videos Folder.

	 Zarejestrowane wideo są wyświetlane w oknie zapisanych obrazów jako miniatury (B7). Po najechaniu 
kursorem myszy na miniaturkę obraz zostanie wyświetlony w obszarze podglądu (B4). 

f)	 Zegar rejestrowania zdjęć i wideo

.

Można ustawić własny zegar rozpoczęcia i zakończenia wykonywania zdjęć lub 
nagrywania wideo.

1.	 Wybierz skrót zegara , następnie wybierz pozycje Photo lub Video.
2.	 Ustaw preferowane parametry.
3.	 Wybierz Start, aby rozpocząć nagrywanie.

	 Nagrywanie zatrzyma się po osiągnięciu ustawionych parametrów lub 
w przypadku naciśnięcia przycisku Stop celem zatrzymania zegara. 



14

g)	Dodawanie oznaczeń i komentarzy
Kliknij dwukrotnie zdjęcie w oknie zapisanych obrazów (B7), aby włączyć interfejs dodawania oznaczeń i komentarzy.

	- Ikona oznaczania 
	- Ikona komentarzy 

	 Menu rozwijane każdej ikony zawiera różne opcje.

h)	Narzędzia do pomiaru obrazu
Kliknij dwukrotnie zdjęcie w oknie zapisanych obrazów (B7), aby przejść do interfejsu pomiaru, następnie wybierz 
ikonę pomiaru .

 Ważne: 
Aby zapewnić precyzyjne pomiary, należy skalibrować oprogramowanie. Więcej informacji można znaleźć 
w części „Oprogramowanie PortableCapture Plus → i) Kalibracja”.

•	 Any Angle Line. Kliknij i przesuń z jednego punktu do drugiego.
•	 Continuous Line. Kliknij i przesuń z jednego punktu do kilku punktów.
•	 Radius Circle. Kliknij i przeciągnij, aby rozszerzyć promień.
•	 Diameter Circle. Kliknij i przeciągnij, aby rozszerzyć średnicę.
•	 Three Points Angle. Kliknij i przeciągnij z jednego punktu do drugiego, zmierz 
kąt, a następnie kliknij myszą, aby zwolnić. 
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i)	 Kalibracja
	 Do kalibracji potrzebna jest linijka.

1.	 Wybierz pozycje: Options  → Crossing → On.
2.	 Ustaw ostrość mikroskopu na linijce.

3.	 Obracaj pokrętło ostrości, aby ustawić ostrość obrazu. 
4.	 Wyreguluj położenie linijki tak, aby obraz był ustawiony w linii prostokątnej z liniami prowadzącymi XY.
5.	 Zrób zdjęcie, gdy wybrany obszar jest wyrównany z przecięciem linii prowadzących, jak pokazano na rysunku.
6.	 Kliknij dwukrotnie zdjęcie linijki w oknie zapisanych obrazów (B7), aby włączyć interfejs „Image Preview”.

1.000

1.000

7.	 Wybierz ikonę kalibracji  → Calibration.
8.	 Kliknij i przeciągnij, aby wybrać punkty początkowe i końcowe na znanej wartości, np. 1 mm na skali linijki.
9.	 Gdy pojawi się okno dialogowe, wprowadź dokładną wartość próbki pomiarowej w polu „Rzeczywisty wymiar”.  

Oprogramowanie obliczy powiększenie. 
10.	Naciśnij przycisk „OK”, aby potwierdzić. Ustawiona wartość powiększenia pojawi się w górnym prawym rogu.
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j)	 Sprawdzanie kalibracji
1.	 Kliknij dwukrotnie zdjęcie linijki w oknie zapisanych obrazów (B7), aby włączyć interfejs „Image Preview”.

2.	 Wybierz ikonę pomiaru .
3.	 Z menu rozwijanego wybierz pozycję „Any Angle Line”, a następnie kliknij i przeciągnij, aby zaznaczyć na skali 

linijki odcinek odpowiadający 1 mm.
4.	 Kalibracja jest prawidłowa, jeżeli wartość w oprogramowaniu jest identyczna z wartością na linijce pomiarowej.

12.	Wyświetlanie obrazu na telewizorze/monitorze
Można używać ekranu telewizora lub monitora komputera jako dużego wyświetlacza obrazu. Więcej informacji  
o wejściach HDMI można znaleźć w instrukcji obsługi telewizora lub monitora.
1.	 Podłącz jeden koniec dostarczonego kabla HDMI do wyjścia HDMI-out mikroskopu, a następnie drugi koniec do 

wolnego wejścia HDMI telewizora lub monitora.

	 Można też podłączyć za pośrednictwem gniazda TV-out przy użyciu kabla audio-wideo.

2.	 Naciśnij przycisk zasilania , aby włączyć mikroskop.
3.	 Naciśnij przycisk trybu , aby przełączyć między trybem zdjęć lub wideo.

	- Ikona  wskazuje aktywny tryb zdjęć.
	- Ikona  wskazuje aktywny tryb wideo.
	- Ikona   wskazuje aktywny tryb odtwarzania.

4.	 Naciśnij przycisk , aby włączyć konfigurację.
5.	 Naciśnij przycisk ▲/ ▼, aby wybrać pozycję „TV Out”, a następnie naciśnij przycisk OK.
6.	 Naciśnij przycisk ▲/ ▼, aby wybrać pozycję „NTSC” lub „PAL”, a następnie naciśnij przycisk OK.
7.	 Naciśnij przycisk , aby zakończyć konfigurację mikroskopu.

13.	Mocowanie statywu
	 Nie należy używać siły do wkręcania statywu do uchwytu, 
ponieważ może to spowodować uszkodzenie otworu na 
śrubę.
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14.	Konserwacja i czyszczenie
	 Nie  używać żadnych agresywnych środków czyszczących. Nie  przecierać alkoholem ani innymi  
rozpuszczalnikami chemicznymi, gdyż może to spowodować uszkodzenie obudowy i nieprawidłowe działanie  
produktu.

•	 Przed czyszczeniem odłącz produkt od zasilania.
•	 Czyścić urządzenie suchą, niepylącą ściereczką.

15.	Utylizacja
a)	Produkt

	 Urządzenia elektroniczne mogą być poddane recyklingowi i nie zaliczają się do odpadów z gospodarstw 
domowych. Po zakończeniu eksploatacji produkt należy zutylizować zgodnie z obowiązującymi przepisami 
prawnymi. 

	 Przed wyrzuceniem należy wyjąć wszelkie baterie (akumulatory) i wyrzucić je oddzielnie.

b)	Baterie (akumulatory)
	 Prawo wymaga od użytkownika końcowego zwrócenia wszystkich zużytych baterii (akumulatorów)  

(rozporządzenie dotyczące baterii). Wyrzucanie baterii z odpadami domowymi jest zabronione.

	 Zanieczyszczone baterie (akumulatory) są oznaczone tym symbolem, który sygnalizuje, że utylizacja wraz 
z odpadami domowymi jest zabroniona. Oznaczenia dla metali ciężkich: Cd = kadm, Hg = rtęć, Pb = ołów 
(nazwa na akumulatorach, np. poniżej ikony odpadów po lewej stronie).

Zużyte baterie (akumulatory) można także oddawać do nieodpłatnych gminnych punktów zbiórki, do naszych  
sklepów, lub gdziekolwiek, gdzie sprzedawane są baterie (akumulatory).
W ten sposób użytkownik spełnia wymogi prawne i ma swój wkład w ochronę środowiska.
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16.	Dane techniczne
a)	Mikroskop
Źródło zasilania.................................................�akumulator litowo-jonowy 3,7 V/1050 mAh (akumulator) 5 V DC, 

500 mA (USB 2.0)
Czas ładowania akumulatora............................ok. 5 godz. (za pomocą zasilacza)
Czas pracy na akumulatorze.............................ok. 4 godz.
Pamięć...............................................................MicroSD, SDHC, SDXC (maks. 32 GB)
System plików karty microSD............................FAT32
Język interfejsu..................................................angielski, niemiecki
Czujnik obrazu...................................................12 Mpx
Rozdzielczość kamery.......................................�12 Mpx (4608 x 2592), 10 Mpx (4224 x 2368), 8 Mpx (3840 x 2160), 

5 Mpx (3072 x 1728), 3 Mpx (2304 x 1296), 2 Mpx (1920 x 1080)
Ogniskowa.........................................................0–60 mm (ręczne ustawianie)
Powiększenie.....................................................�optyczne: 10x do 300x 

cyfrowe: 1,1x do 4,0x
Format zdjęć......................................................JPG
Format wideo.....................................................AVI
Rozdzielczość wideo.........................................1920 x 1080p, 1280 x 720p
Szybkość klatek.................................................maks. 30 kl./s
LED....................................................................maks. 500 luksów (białe)
Warunki pracy....................................................od +10°C do +40°C, 40–85% wilg. wzgl. (bez kondensacji)
Warunki przechowywania..................................od -5°C do +50°C; 40–85% wilg. wzgl. (bez kondensacji)
Wymiary (szer. x wys. x gł.)...............................108 x 160 x 37 mm
Masa..................................................................213 g (z akumulatorem)
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b)	Oprogramowanie
Obsługiwane systemy operacyjne.....................�Windows® 7/8/10 (32/64-bitowy) 

Mac OS 10.14 lub nowszy.

c)	Zasilacz
Napięcie wejściowe...........................................100-240 V/AC
Wejściowa częstotliwość  
prądu przemiennego..........................................50/60 Hz
Napięcie wyjściowe...........................................5,0 V
Prąd wyjściowy..................................................1,0 A
Moc wyjściowa................................................... 5,0 W
Średnia sprawność podczas pracy....................≥73,62 %
Sprawność przy niskim obciążeniu (10%).........N/A
Zużycie energii w stanie bez obciążenia...........≤0,10 W
Identyfikator modelu..........................................DSA-5PF02-05 FEU 050100

Numer w rejestrze handlowym: HRB 3896

Producent: Conrad Electronic SE, Klaus-Conrad-Str. 1, D-92240 Hirschau
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